Canon

Picture Style File Creating Software

Picture Style Editor
Ver. 1.14
Instruction Manual

Content of this Instruction Manual
PSE stands for Picture Style Editor.

» indicates the selection procedure of the menu.

(Example: [Picture Style Editor] menu » [Quit
Picture Style Editor].)

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.
Click to move to the relevant page.

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

Switching Between Pages
Click on arrows on the bottom right of the screen.

@ : next page
€D : previous page
: return to a page you had previously

displayed
Click on the headings on the right side of the
screen to switch to the contents page of that
heading. Also, click the item you want to read
about on the table of contents to move to the
relevant page.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Picture Style Editor (hereinafter, “PSE”) is software that allows you to edit
Picture Style to your unique image characteristics and save the edited
results as original Picture Style files.

What is a Picture Style file?

A Picture Style file (extension “.PF2” or “.PF3") is an extended
function of a Picture Style. It differs from the seven preset Picture
Styles (Auto, Standard, Portrait, Landscape, Neutral, Faithful and
Monochrome) and provides image characteristics that are effective
in a very limited number of scenes.

You can further expand your photographic expression by using a
Picture Style file effective for a specific scene.

Main Features of PSE

With PSE, you can use the functions below to edit Picture Style to
your unique image characteristics and save the edited results as
original Picture Style files (extension “.PF2” or “.PF3").

Select a Picture Style to be used as a basis for your images

Set the [Sharpness], [Contrast], [Color saturation] and [Color tone]

Make adjustments to a specific color

Adjust the brightness and contrast (gamma characteristic)
In addition, you can register your saved original Picture Style files on
a camera with the Picture Style function and then apply those styles
to shot images. You can also use Digital Photo Professional
(hereinafter, “DPP”) to apply the styles to RAW images.

Color Management

Use PSE in a computer environment with color management.

Also, set the profile of the monitor you are using and the color space
of the sample image to be used to perform the adjustments, etc. in
the preferences window (p.19).

System Requirements

(O Mac OS X 10.8, 10.9
Computer | Macintosh with one of the above OS installed
CPU Intel processor*1
RAM Minimum 2GB
- Resolution: 1024 x 768 or more
Dol Colors: Thousands or more

1 Core 2 Duo or higher is recommended.
This software program is not compatible with UFS (UNIX File System)
formatted disks.
Check the Canon Web site for the latest system requirements,
including supported OS versions.

Sample Images for Adjustment

PSE enables you to use RAW images shot with EOS DIGITAL cameras*
(excluding the EOS DCS1 and EOS DCS3) as sample images for
adjustment. You can then save the completed adjustments as original
Picture Style files.

* Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.

For information on CR2 Converter, refer to Canon Web site.
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Preparing Sample Images

PSE uses a sample image to perform the various adjustments and save

the adjusted results as an original Picture Style file. For this reason, a

sample image (p.2) to be used for this purpose needs to be prepared in

advance and saved on your computer.

The settings performed in PSE are saved as a Picture Style file (p.18)
which is separate from the sample image, and the sample image used
to perform the adjustments is not affected at all.

Starting up PSE

Click the [Picture Style Editor] icon in the Dock.
The main window (Description on the right) appears when PSE
starts up.

|§| You can also start up PSE from the camera software “EOS Utility”.
Refer to the “Function for Use with the Accessories” of “Reference
in “EOS Utility Instruction Manual” (PDF electronic manual) for
details.

Opening a Sample Image
Open a sample image and perform various adjustments with that image
as a basis.

Noise reduction to the sample images may be applied by PSE included
in EOS Solution Disk Ver.26 or later.

Drag and drop a sample image to the main window.

Drag and drop

The sample image is displayed in the main window with the
camera settings at the time of shooting.
The [Tool palette] appears.

|§| If you open an image as a sample image with PSE, the shot
settings on the camera will appear in the image. However, the
Auto Lighting Optimizer settings will not appear.
If you adjust a RAW image in DPP and then open it as a sample
image with PSE, the adjustments made in DPP will not appear in
the image.
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Basic Windows
Main Window

You can select the display magnification and the display method, etc. of the sample image.

Picture Style Editor - [ MacOSX/Users/canon/Desktop/_MG_0001.CR2 |

866

Image rotation

(90 degree
increments to the left
or right)

Before and after
adjustment
comparison display
(Top/bottom split)
(p-6)

100% (actual pixel size)

Before and after view

adjustment
comparison display

(Left/right split) (p.6) Full view

Normal screen Display magnification
(5 ratios: 12.5%, 25%,

Cursor coordinates 50%, 100% and 200%)

position

X:2286 Y:668 HSL: 213,7,82] > [213,7,82] (+0,+0,+0)

Work color space: sRGE

Work color space display (p.19)

Color values of the cursor position (Before adjustment/after adjustment/
difference between before and after adjustment) (8-bit conversion)

Color display mode (p.17)
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Enlarging a Specific Area
You can enlarge a specific area in the main window to 100%.

In the main window, double-click the area you want
to enlarge.

ana Pacture Style Edvor - | MacOSX/Users/canon, /Desktop, MG 0001.CR2 |

Double-click

Wikt 1pace AREN

The area you double-clicked is enlarged to 100% (actual pixel
size). If you wait for a while, it changes to a clearer display.
To change the display position, drag on the image or drag the
enlargement display position (p.7) in the [Navigator] window.
Double-click again to revert to the full view.

Adjusting While Comparing with the Original Image

You can display before and after versions of an adjusted image in the
same window and perform adjustments while checking the adjustment
results.

Introduction
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Select [[E]] or [[(m]].

BTl

X:2275 Y:617 RGB:[183,199,216] > [183,199,216]

-» The images are displayed split top and bottom or left and right.

[[E]] (Top/bottom split) display  [[[#8]] (Left/right split) display

The image before adjustment
is displayed at the top, and
that after adjustment at the
bottom. right.
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) . . Introduction
Navigator Window Setting the Warning Indicators

You can set warning indicators for luminance values (Y) and color
values (RGB) which are useful for preventing excessive settings being

The display position of an image when it is enlarged in the main window

igg ;rllset)lr;]:tgv?/:rlrsl;[r?griirdnicce?[grzet:Isrpel\?()e/(ne?elzgggs?\?:s?:ttt?r: V;'rgde?r\:v' You made. Luminance and color value domains which are outside the set Contents
made 9 P 9 9 range blink as warning indicators on images in the main window.

- . . Checkmark [Show warning on images] and select [Y Preparing

Display the [Navigator] window. [ 9 ges] Y] a Sample

Select the [View] menu » [Navigator]. or [RGB].

0 Mavigator

Basic

Windows
£ Show warning on images

oYy
) . Pre-adjustments
Enlargement display position
(p-6)
Move the display position by |
. . . . mage
dragging Enter the upper and lower limit values of the warning Charactgistics
range. —
The domain where values are outside the upper and lower limit of
—— Switches the histogram display the range blinks on the image in the main window. Saving
To stop the warning indicators, remove the check mark from the
[Show warning on images] checkbox.
Histogram Preferences
Reference
© Show warning on images Warning indicator setting @ @
oy
. e < . Warning range @

|§| [Y] in the histogram display indicates luminance.



Introduction

Tool Palette )

You can adjust the image characteristics of the Picture Style file by using the various functions of the [Tool palette].

The adjustments made with the [Tool palette] are immediately applied to the image in the main window, enabling you to check the results as you work. Contents
We recommend that you make adjustments in the following order. —
(1) Adjust with the [Basic] tab sheet (p.10) _

(2) Adjust with the [Six Color-Axes] tab sheet (p.12) I;rgggqr gl‘g

(3) Adjust with the [Specific Colors] tab sheet (p.13)

[Basic] Tab Sheet [Six Color-Axes] Tab Sheet [Specific Colors] Tab Sheet
Make basic adjustments to image Make color adjustments to image Make fine adjustments to a specific Windows
characteristics. characteristics. color gamut.

Basic

Pre-adjustments

== | i
/ | / - | =]
Base Picture Style :

. [ S I

B show affected area on images R

01 2 3 4 5 6 7 8 9 10
Sharpness : 'S

Image
Characteristics

-4 -3 -2 -1 0 41 42 43 44
Contrast : 2

4 -3 <2 -1 D 4+l 42 43 +4

Color saturation : 8,

-4 -3 22 -1 0 41 42 43 44

Color tone :

Saving

Tone cu rve (RGE) :

|

Preferences

S —

Reference

—_—

|§| You can select the [View] menu » [Tool palette] to switch the [Tool
palette] show/hide.



Pre-adjusting the Images

Sample images used in the adjustment process (p.2) which do not have
proper exposure or white balance can be adjusted using the
[Preliminary adjustment] window to correct their brightness and white
balance.

However, please remember that adjustments made with the [Preliminary
adjustment] window are merely pre-adjustments for performing
adjustments with the [Tool palette] (p.8). For this reason, adjustments
made with the [Preliminary adjustment] window are not saved in the
Picture Style file which you create.

If the sample image used for adjustments has proper exposure and
white balance, it is not necessary to make adjustments with the
[Preliminary adjustment] window.

Correcting the Brightness

Select the [Tools] menu » [Preliminary adjustment].
The [Preliminary adjustment] window appears.
When the [Preliminary adjustment] window appears, the display
switches to normal display, even if the main window display is
showing a comparison of images before and after adjustment

(p.6).
Adjust to correct the brightness of the image.

0 Preliminary adjustment

Brightness adjustment :

Drag to the left or right
to adjust

White balance adjustment ©

Shot settings

The adjustments are applied to the image.

Correcting the White Balance

Adjust to correct the white balance.

(&) Preliminary adjustment

Brightness adjustment :

White balance adjustment ;

Color temperature

Click the [ _]] button

and then click on a point
that is to be the standard
for white

The color temperature slider
Select [Color temperature] from the white balance
list box, then drag the slider left or right

Select the white balance

The adjustments are applied to the image.
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Making Basic Adjustments to Image Characteristics

Use the [Basic] tab sheet in the [Tool palette] to make basic adjustments
to image characteristics.

Select the [Basic] tab in the [Tool palette].

Load a Picture Style file (this page)
|

tase Picture Style : (p . 18)

Select a Picture Style to be
used as a basis (this page)

Sharpness

4 -3 2 -1 0 41 42 43 44
Contrast : ]

4 -3 -2 -1 0 +1 42 43 +4

Adjust Sharpness, Contrast,
e o Color saturation, and Color
Color tone tone (p.ll)

Color saturation : ]

Tone curve (RGB) :

Adjust the Gamma
Characteristic for RGB (p.11)

The [Basic] tab sheet appears.

Selecting a Picture Style to Be Used as a Basis

Select the Picture Style used as the basis of the adjustments from the
five preset (except Auto or Monochrome) Picture Styles (Standard,
Portrait, Landscape, Neutral and Faithful).

You can also register and use a Picture Style file effective for the scene
that you have downloaded from Canon Web site.

Select a Picture Style.

800

Tool palette

Base Picture Style :

Standard

The selected Picture Style is applied to the image.

Using a Downloaded Picture Style File
Effective for the Scene
Click the [(&']] button.
The [Open Picture Style file] window appears.

Select a Picture Style file to be registered and click
the [Open] button.
The selected Picture Style file is applied to the image.

|§| Original Picture Style files created with PSE (p.18) can also be

registered and used by following the procedure above.
Picture Style files compatible with PSE are files with the “.PF2” or
“.PF3” extensions.

R

Introduction

—_—

Contents

—_—

Preparing
a Sample

Basic
Windows

Pre-adjustments

S ——

Image
Characteristics

Saving

Preferences

—

Reference

10



Introduction

Setting Sharpness, Contrast, Color Saturation and Color Tone Adjusting the Gamma Characteristic for RGB ———
Drag each slider. ;%JBcan use the tone curve to adjust brightness and contrast under i

Use the tone curve in this tab sheet before adjusting with the [Six Color- ‘"
Axes] tab sheet or [Specific Colors] tab sheet.

Sharpness : .
Preparing
. . [
Adjust the brightness and contrast. a Sample
Contrast :
Tone curve (RGE) : BaSIC
Color saturation : Windows
Click to add a [[]
(adjustment point) and
Color tone : . . .
adjust by dragging Pre-adjustments
—_—

The settings are applied to the image.

Image
Characteristics

The value of the
selected point (you can

also enter numerical .
values) Saving
The brightness and contrast of the image change. —
The horizontal axis shows the input level and the vertical axis
shows the output level. Preferences
The maximum number of [[]] is 10. —
To delete a [[], select the [[]] and then either press the <Del>
key on the keyboard or double-click on the [[]. Reference

|§| Note that if you adjust the tone curve in the [Basic] tab after making
adjustments with the [Six Color-Axes] tab sheet or [Specific Colors] @ @
tab sheet, the color characteristic will be further adjusted and
intended image characteristics may not be achieved. To further @
adjust brightness and contrast after adjusting with the [Six Color-
Axes] tab sheet or [Specific Colors] tab sheet, use the tone curve for

adjusting luminosity in the [Specific Colors] tab sheet. 11



Adjusting Color

You can adjust the color region you selected using hue, saturation, and
luminosity.

Select the [Six Color-Axes] tab in the [Tool palette].
Load a Picture Style file (p.10)

Save a Picture Style file (p.18)

Hue region select buttons
(this page)

Adjustment color wheel
(this page)

Hue adjustment sliders (p.13)

The [Six Color-Axes] tab sheet appears.

|§| Note that if you adjust a color with the [Basic] tab sheet after making
adjustments with the [Six Color-Axes] tab sheet, the color
characteristic will be further adjusted and intended image
characteristics may not be achieved. We recommend that you make
adjustments in the following order.
(1) Adjust using the [Basic] tab sheet, (2) adjust using the [Six
Color-Axes] tab sheet, (3) adjust using the [Specific Colors] tab
sheet.

> J

Select the color region you want to adjust.

[ I [ N T

Select the color region you want to adjust from the adjustment
color wheel.

You can also select the color region by clicking a hue region
select button.

Adjust the upper and lower hue limits for the
selected region.

You can adjust the upper and lower hue limits for the selected
region by dragging the boundary lines for each hue in the
direction of the circumference.

Introduction

—_—

Contents

—_—

Preparing
a Sample

Basic
Windows

Pre-adjustments

N —

Image
Characteristics

Saving

Preferences

S —

Reference

—_—

QO
©

12



Adjust color.

Drag the sliders to adjust color. You can also directly enter values
to adjust.

H: Adjust hue.

S: Adjust saturation.

L: Adjust luminosity.

Making Minute Adjustments to Color

You can make minute adjustments to a color you have specified, using
the hue, saturation and luminosity functions in order to get the color you
want. You can also set a range for the effect on surrounding colors
which occurs when you adjust the colors you have specified.

Select the [Specific Colors] tab in the [Tool palette].
—— Load a Picture Style file (p.10)

800 Tool palette

DLy <-i-coo- [ Save a Picture Style file (p.18)

B show affected area on images

>

Minute adjustments to
a specified color (p.14)

L]

o pm
o g
.

Adjustment color list (p.16)

- Ca—
s o Color display mode (p.17)
L 39 >38

Output :

L Adjust the gamma characteristic for luminosity (p.17)
The [Specific Colors] tab sheet appears.

|§| Note that if you adjust a color with the [Six Color-Axes] tab sheet or
[Basic] tab sheet after making adjustments with the [Specific Colors]
tab sheet, the color characteristic will be further adjusted and
intended image characteristics may not be achieved. We
recommend that you make adjustments in the following order.
(1) Adjust using the [Basic] tab sheet, (2) adjust using the [Six Color-
Axes] tab sheet, (3) adjust using the [Specific Colors] tab sheet.
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Specify the color you want to adjust.
Click the [[_2 ]] button and then click the color you want to
adjust on the image.

B show affected area on images

—— Click

Picture Style Editor

Click

The selected color is displayed as an adjustment point [{ZJ)] on
the color wheel.

Determine the range of effect for the color you want
to adjust.

Within the frame is the range of effect

Color of the adjustment point selected in step 2

Range of
upper and
lower limit of
luminosity
Drag to
move up or
down

Luminosity level of the adjustment
point selected in step 2

Range of upper and lower limit of saturation
Drag to move towards the center or towards
the outer perimeter

Range of upper and lower limit of hue
Drag to move along the circumference

The range of effect for hue, saturation, and luminosity can be set
within the limits below.
Setting Range
Hue 30 - 180 degrees
Saturation 30 - 100
Luminosity 30 - 100

Introduction

—

Contents

S —

Preparing
a Sample

—

Basic
Windows

e

Pre-adjustments

S —

Image
Characteristics

Saving

Preferences

S —

Reference

e

QO
©

14



Adjust the color.

Drag to the left or right to adjust

The color is adjusted to the range specified in step 3 and the
color of the image changes.

When dragging the slider, the point before adjustment [ (1] and
the point after adjustment [ i ] will be displayed on the color
wheel.

Check the range of application.
If you checkmark [Show affected area on images], the range of
application of the adjusted color blinks on the image.

':-.j} o e} Specific Colors 3

B show affected area on images

— _
e G )

Repeat steps 2 to 5 to adjust multiple colors.
You can select and adjust colors for up to 100 spots.

When using EOS Utility’s Remote Live View function with PSE to
edit Picture Styles, the [Show affected area on images] checkbox
is not displayed, and you cannot check the range of application of
adjusted colors.

You can also specify the color to be adjusted in the method
different from the one explained in step 2 (p.16).
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Specifying the Color Directly

In addition to specifying the adjustment point by clicking the color on the
image (p.14), you can also specify the color directly on the color wheel
or by entering the color value.

Specifying the Color on the Color Wheel
Click the [[_# ]] button (p.14).

Click the color you want to adjust on the color wheel.

The selected color is displayed as an adjustment point [{C1] on
the color wheel.

Specifying the Color by Entering the Color
Value

Select the [Edit] menu P [Specify the numerical
values for color adjustment].
The [Specify the numerical values for color adjustment] window
appears.

Enter the color value.
The entered color value is displayed as an adjustment point [ ()]
on the color wheel.

Displaying the Adjustment Color List and its Functions

In addition to displaying colors before and after adjustment, the
adjustment color list (p.8) shows overlapped range of effect of adjusted
colors, and has a checkbox for specifying whether applying adjusted
colors or not.

Ee———————— Color before adjustment

Color after adjustment

\
Displays overlapped range of effect of adjusted colors

Remove the checkmark to disable the adjustment

Overlapped Range of Effect of Adjusted

Colors

When you select an adjusted color from the listand [[ T | ] appears, the
range of effect of the adjusted color (p.14) is overlapping with the range
of effect of other adjusted colors.

Moreover, the overlapped areas will be displayed in gray on the color

wheel and an adjustment combining the original adjustments is applied.

To avoid an overlapped ranges of effect, select the subject color with
[[T1] and adjust it again so that the range of effect of the hue and
saturation no longer overlap.

Deleting an Adjusted Color

Be aware that you cannot recover deleted colors.

From the list, select the adjusted color you want to
delete and then press the <delete> key on the

keyboard.
The selected adjusted color is deleted.
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Color Display Mode

You can select the color display mode which will be the basis for color
adjustment from three options (HSL, Lab, or RGB) as well as checking
values for adjusted colors.

w )

SL '+ omm— Switches the color display mode
?} 23

5 || 47 = 60
L} 58

Color value after adjustment

Color value before adjustment

When “HSL" is selected for the color display mode, you can only
change the color value for before adjustment by entering a
number.

|§| HSL is a color display mode using the three elements of hue (H),
saturation (S), and luminosity (L).
Lab is a color mode developed by the CIE (Commission
Internationale d’Eclairage) where L is for lightness, a for color
elements from green to magenta, and b for color elements from
blue to yellow.
RGB is a color display mode using red (R), green (G) and blue
(B), the three primary colors (additive colors) of the visible light
spectrum.

Adjusting the Gamma Characteristic for Luminosity

You can adjust the brightness and contrast for the luminosity of the
entire image using the tone curve. To further adjust contrast and
brightness after adjusting image characteristics with the [Six Color-
Axes] tab sheet or [Specific Colors] tab sheet, use the tone curve in this
[Specific Colors] tab sheet.

Adjust the brightness and contrast.

Click to add a [[T]
(adjustment point) and
adjust by dragging

| &
nput | | The value of the
Output : l selected point (you can

also enter numerical
values)

The brightness and contrast of the image change.

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[O] is 10.

To delete a [[], select the [[]] and then either press the
<delete> key on the keyboard or double-click on the [[].
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Saving the Adjustments as a Picture Style File

Adjustments specified in the [Tool palette] (p.10 to p.17) are saved on your
computer as an original Picture Style file (extension “.PF2" or ".PF3").
The adjustments are saved as a Picture Style file which is separate from
the sample image, and the sample image used to perform the
adjustments is not affected at all.

Click the [[&]] button.

The [Save Picture Style file] window appears.

Specify the name and destination and then click the
[Save] button.
Only one-byte characters can be entered in the [Save As],
[Caption], and [Copyright] boxes.
If you do not want to show the settings adjusted in PSE,
checkmark [Disable subsequent editing] and save, so that the file
cannot be opened again in PSE.

Save Picture Style file

Save As: m

| —

Where: -Kﬂ Desktop ﬂ

Format PF3(.pf3) :]

Caption :

Copyright :

] Disable subseguent editing

- r——
[ Cancel ) Save

The file is saved as a Picture Style file in the specified save
destination.

® After adjusting with the tone curve in the [Basic] tab sheet or with
the [Six Color-Axes] tab sheet, save results in .PF3 file format.
Results are not saved if saved in .PF2 file format.

|§| Even if you checkmark [Disable subsequent editing] and save, you
can use the Picture Style file the same way as the Picture Style file
without chekmarking and saved (Description on the right). However,
you will no longer be able to open the Picture Style file in PSE. For
this reason, we recommend that you save separately beforehand the
Picture Style file without checkmarking [Disable subsequent editing].

Using a Picture Style File

Saved Picture Style files can be registered in the camera and applied to
shot images. They can also be applied to RAW images using DPP.

Registering a Picture Style File to the Camera

Picture Style files saved on your computer can be registered to the
“Camera that has a Picture Style function settings” (For information on
whether your camera is equipped with the Picture Style function, refer to
the camera’s Instruction Manual.) using EOS Utility and applied to shot
images.

Refer to “Applying Picture Style Files to the Camera” in “EOS Utility
Instruction Manual” (PDF electronic manual) for details on operation.

Using a Picture Style File with DPP

Picture Style files saved on your computer can be applied to RAW
images using DPP.

Refer to “Using a Picture Style File” in “Digital Photo Professional
Instruction Manual” (PDF electronic manual) for details on operation.
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Preferences Quitting PSE |
_ o Introduction
You can perform color management settings such as specifying the In the main window, select the [Picture Style Editor]
wor_k color space for the sample image displayed in the main window, or menu » [Quit Picture Style Editor].
setting the profile for the monitor. ,
PSE quits. CaTEN S
Select the [Picture Style Editor] menu » [Preferences].
The [Preferences] window appears.
. . . . Preparing
Specify the required settings and then click the [OK] a Sample
button.
rB 00 Preferences ) Basic
Work color space WindOWS
® sRGE
") Adobe RGE
Pre-adjustments
Color matching settings —
For display Image
® ik , Characteristics
_ Monitar profile
Saving
The settings are applied. Preferences
|§| If you have changed the work color space during the adjustment @

process, the adjustment point on the color wheel may move in
conjunction with the selected work color space.
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Reference
Troubleshooting

If PSE is not operating correctly, refer to the items below.

Installation could not be completed correctly

You cannot install software unless you are logged into an account with
Administrator privileges. Log in again into an account with
Administrator privileges. For how to log in and how to specify
Administrator settings, refer to the user’s manual for the Macintosh
computer you are using or for Mac OS X.

PSE does not work

PSE does not operate correctly on a computer if its system
requirements are not met. Use PSE on a computer with compatible
system requirements (p.2).

Even if your computer has the RAM capacity (memory) described in
the system requirements (p.2), if other applications are running at the
same time as PSE, you may not have sufficient RAM (memory). Quit
any applications other than PSE.

Images do not display properly

Sample images that are not supported by PSE (p.2) do not display.

Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

To uninstall the software, log in with Administrator privileges.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

Drag the [Picture Style Editor] folder to the Trash.

Select the [Finder] menu on the desktop » [Empty

Trash].
The software is deleted.

Restart your computer.
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You cannot retrieve data that you have emptied into the Trash
and deleted, so be particularly careful when deleting data.

You cannot install the software again if you have just moved the
[Picture Style Editor] folder to the Trash. Be sure to select the
[Finder] menu » [Empty Trash].

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

Macintosh is a trademark of Apple Inc., registered in the United States
and other countries.

Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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